Q2sAdll Heeadl
€2didoe] USIRIol

OpenOffice.orgel A Gudlal 301 eacldy olrlldell R oflvll o, Bl usEML WU 254
el Q25 ASuAR0L Aigedr RA vl s am Qs siwerdl va 2l s, QU oue 25udidari
Gudlol &0 A2su 56 A quud A erllyy, 20 Vs 25 A A5 AWigedrq Bsm wRag Wy 8.
il SciTE ¥Raa-ll ugt wuda a8,

A25ul 6wl (Use of LaTex)

d25u AR A2 A5 Rdw Algedrll w3 W Wil 25 A oflm qwudl dged-l wwda
wy B, 2suada W wweeid Gog ROGeYMl Guash vs o dlsBiy Q2su Rdww g
8. wW6ey2 Aal W2 oflm wel ARR 2 Algedarll uR R W, NwWE AU gel-gel wRULML
sl glfauaviini wiGeye WA V. W W2 gidamavid MR Gy WAl W2 yel-yel
Aoifa Agedal ¥R W B.

A uel Wwel 2s2-AUR23 GudL 50N A2sAr) greider -l sy (Fau & gedit xual SciTE).
ERAUAY birllddl W2 dll Yel-yel cudlld A2suel st A Rlkd s 2ud 8. Gelgrel adld, erdidy<d
s wuval W2 \title sl Gudlol WY B, edyell Quisd AWn @ual \anthor dXY erldoy-il
gl e vuval W2 \date sl Gualol wd @, v o d, \chapter, \section, \subsection,
\paragraph a9 U= tdyd dil¥se woy] sididal W2 QWY 8,

2L ecldy adauPs delldi dlsaal W2l MidRs Wclv)l A2snl Guasd B, U IR ey
ariel quflal ¢lu, A R U WA dNsasll adlRd, aviel o 2wd B, UL Wl d2su Lrdldy
GuR uBW s W Gy #dd oid B, WA-WA d2dls awiuddl s1ddl weL ad B, AR al
Boaudti 20 quridl g6l A u WRA dpuen adRr YPla A (RR2) 2 &1 wsu 8.

o wud Wou Algedre(l deedll B2Y2 g1 ASY uual Birer ad Bire sdly), R R B
afffd vl AsAd By Al HARl, A BUNR A WL guiiqdl Age &S dl, 2uuad
widRs el vyl 2vel Ddaidl deldl Gualal s34 ercidarii IR 53w,

I edlldodl widl R8I S, Al F]§RA AR WGyl Al W2 ealdwd Y-
sade KAl il 2 A A2sA oA tex §18a dddoddl Guila 51 B, A2suni ¢d pdflatex
s Guash 8, ¥ PDF (Portable Document Format) *uavusi 2uB2yz 2l 8. PDF sida-
W Gur A wsy B, dny Bieearl ucedll Bee Wl #ndl sy B ¥ Bz AR 6w
rd B ddl o susdlds 4d dsiuge GUR eadidwd Qdra (ARA) KA w2 PDF sida wu
o nulid O, Gorg-l evince dlsyive R wWs2dW PDF trdidasl A usin 8. ol eridwq
AURA-sUdd udl Al s34 20 Has B -

e Gedit ¥ A8 Wel 2e-AR2{l Aeedll eadidy AWRA s

o ol 2usda Aa 1 du d RN pdfiatex filename < a} M2 GURAL ecdx
Sydd N

asu-ll needll ereudwy st 241
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o GUIl sge Q@ vadl s W2 GWYl evince pdffilename s w{ld adel PDF sidas
il (W dd PDF s18a ot sael, R usl o 2BiHa aud Mime 2vigd)

d2su s1daHl YaRIAWA Ral W2 Ul SciTE (wde) MRz-D Gudlal &0 afld ¢l gedit
w SciTE ol (R2sq) disaaa-udl madt A delld s2ami 21d 8. (dinasl W wdavanl
WAl W2 ol el w2l wad ol sulaand d B), gedit WR2R sdl SciTEHL As
SUEL 3 B % dul ¥ Ldldyd swdd s AS W 8. dail ot ¥, SciTE ARzl WRRd
¢l R d2sn eglal R 2wl SciTE-D o Gudla sdlg, Wldws d2su A SciTEA Gudsl
KAl HEZ WRerl vddi wwla WRd yas sfFoyladt sidadi e LA W w3 digedr
wald sl ugl Gulosdln ssd Wy o Qud W sl R W D,

4254 oMl (The LaTex Language)

A2su A Yo A WU euml B, A2sA- ML WE @vlel dMy Ay auiel &y
B, ¥ U ddd v wwd B, kdls s ddad G B, d QuuEl S8 Wl cud
Fond sadt el ial sles sl A25u sxdldaell uBuL 53 O AUl umlisal Mewasl sl sl
S 8, Ak auiel daa exidy RAdl uRd yd wld 8, ekdidw-t wavuuni Rl e
aviedl o euld 8. (uAd wWew sRA A2sA avied A wavidl dsd B) o AARAY
slsaglld awavf 2l 8 wudl AU erddy-l AsA WBW Al Fa- A B (Gewwl
dild, MRd welidl sed Gudldl 5d), A4 dolkeil o Gl ¥ «d WA 93 g W)

d2sauril el A3vd \SLRAA AR Wl st M W Ad wd B, S B g4d HUAA
pyal yuad Raad s vaRd odd &y 8, Qs sus uAMRRa 8, (GRea (you)
B Al WA Wedl wadl AR B) fedls Ut an-l R uR sk 8. (Gelsww
\textcolor slesii @vi@l 0 P galad B, d L U wud W B) w audl wRdA
A a3 ovami wd B,

oz Yo & wsRel da B, Asf@s woddl-e, A WA 2l Wiz sl dl Al
il 2z e 2l WA waal A el duye wd A WA 2l B wyd B
Rl qud AsfAs wedire wudl du, dl dd sussrl o ugl [ ] (AR SRed) R
09 il sy, o Wi ugl { ) (soRw Sl wld sl weddAe (A Qu dl)

vl 2ud 8, Gewsel ddld, \documentclass[12pt]{article}; su-ili documentclass 3L s¥ivde
Ad 8. 12pt W Asf@s sz B wwd article W HPrud wWHA-e 8.

A2l ot ¥ cdlfe WA AN (U, 200 A il aAdd) @ S Auy WAL dd B,
Ak Rl v itz A A As vaw yRalda s wd 8. Al agvudsl wiydmi
ldd adldz WA VI NARAML B B A W sl dR vudl A aa gsudl uIviid
gt Wd 8. Wed Ul Adast W wdl F NEL AwRA ¥y sl awd Al axlly, A
wel d avued ol Y il dldl AR wd, i Yl A 2w6eyeHi Udd a@vu@ i3 ¥ eulad
o @Rl ddl il GRA Qu, d W\ (asd s sus) Al viddnl qmd W 8. uig
gourll Beell andmai 2 s wuarl ¥R Al s 12,130 g Add @WURL dul @viRi
A8l Gl Geled®m siuani wdg B. (textsf sl Al wedl sqg) 2ugl 122 Qs
gldad wGeye suld 8B,
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\documentclass[12pt]{article}
\title{Line handling in \LaTeX}
\date{May 2013}
\begin{document}
\maketitle
\section{Continuous Text}\textsf{
We have no wings, we cannot fly
But we have legs to sail and climb
By slow degrees and by and by
The cloudy summits of our time}
\section{Text with Seperate Lines}\textsf{
Heights by great men reached and kept \\
Were not attained by a sudden flight \\
But they, while their companions slept, \\
Were toiling upwards in the night}
\end{document}

wgld 12.1 : Dl Auandd Gegm caladl sty

1 Continuous Text

We have no wings, we cannot fly But we have legs to sail and climb By slow
degrees and by and by The cloudy summits of our time

2 Text with Seperate Lines

Heights by great men reached and kept
Were not attained by a sudden flight
But they, while their companions slept,
Were toiling upwards in the night

ugld 12.2 : did-duaq-u Geagadg wubay2
(A A 2 d2surl wdAMd (Reserved) wal €.
# $ % & _(wgrslR) { } A ~ \

A2suul 2 WAAD vn ¥ D, W AN AARAD Gudlol A2sueil aviel S asdl Al
Al WL A WMA quieil Addl €Y, dl d Ay avlld avdl wsny 9,

W% % &\ W \~{} \textbackslash(}

Seal A8t g wuA Y dl Ra < ud > g€l o dAd swy 8. (e Q8 Bar) d qua W2
\textless -\ \textgreater vl W 8. * (Ao A2 viYdl Hs52) i ' (AWRAS iUl P2 H2)
Guuldl @vieid A5 NAdRRRAHL gl M2 Wy 8. sld., ‘Book Code'. 8 uad@@Ba el w2

sl Ba & aud auwai @@ 8. eld. "Book Code”. (vl 8 amd awudal Rde 52 8, 25 amd
avidd ot Sl2 dl) d sudadl e QARLL Fld evud @ uig wGyedl wwll Ad ety &,

azsu-dll ueedl erudyd wsan 243
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Azsu avi@rl euald Rifa sl W2 ol Gudlol 53 8. sudl o wolRul Sid { A Jal awauwi
21d B, 2l gUHl SUNAUHD sUdal S URL SR F5d YuML W S WSl QBRI ¥ BAR
528, A s s guHl DU 8 F Wil U Ay W 8. U W avirt ¥q 3 L cuay,
Dl iAW)l 3 ssuN oy — e ASWA @R ual W Guadll 8.

a3 W Avadl U d) didal QU (Gegr a3 el alsagll sl u wna suflas wdlse
avig d1u) iedl aviedl A6 M2l eudd uru sl el AR Ul Y (L F ERL SlL g,
2Ll @eUdL) AR A2sA Bs nadl wads Yl uR 8. U WA Az adld o wd 8.
21 B2 \begin{environment-name} siwsell 93 Ay S A \end{environment-name} il
Y3 w8,

AriAlil adle oL % dauiRl GuR Avusddvedl sl o (BEL) wanifly qiaisal qwis, W B,
Arquuediee ARS va QS ud; Ay Arqueddeni ofly Ayl du da RS Arcludle sdam, sl
Jeals (Quuag-l SR HWIRL el Yel aed drawsd-e 8. a3 s (equation), adw
(quotation), 2etel 317} 41€) (list). 2 st o AraiurA-e deil (AuYarg WA dwR FHERL s11- WA 204 B,

Azsudl erldyl ol usiy & dxy uelld A asu B, A2l yel-yel aiotl Fa (@afisdl)
8. B3 UL R, L) AS5 cud WWAARA 6Nl HAAL WS Sdl 9Y EUAR si-iadl
(Adau®) dHy 2y oifm waal A gl siridd 2wd2 viydl Ul Gualdl SRl J2dls quid il
2ffad ygl d2suel A8 viaadl w3z w8,

sual G o4 ewid Rddar Rsdna wuvael wwa S ol alsd wadiell piw al 8.
21q [@oldela RsAvw sidl-edl ool 30 2l unu. Qs % Rell A2 13 50 wsin B %
uglg sy aviel, dA 2id Yl sd-e ddd oweuu B, sid-e W 2Rzl Wa Sk aludl W2,
UMYl M2 B ¥I2 ARUL AL YRR $2ell W2 Guddtsdlnl Guaell B, duddaqni Sidve vqariei
2id & duy beyeHi ua silred AS Wi &g Al

a25u gAY ] (The Structure of a LaTex Document)

Q25U LAl 6 oL B 1 AL WA RNudRg, Mdiaqiil A2ika (Rl wRA) du 8. A2l
A eldy RAA WRA 8. (Gerswt a3, 2 I UsRAL LAY B, tcdldy«ll Auis S8 O, trdldy
s3 ol-1dd B) 2 A5 txldy-l UGB &85 A 54, A1 Ya-u du B, ya ANy ddai A-au-dd-e
txldadl du 8, ¥ \begin{document} 7 \end{document} sHi=¢{l 92 druda &y B,

wallds sudt (The Preamble)

A2l RRYAMeR qsust gEl-gEl dlaRisal v ervnal gkady o-dl usy 8. 24 2 wmeq
o3dl B % 3o s1dd a3 s usRL ey GUDL A B, Jdia-i Wl udg dw (WRA-e)
\documentclass{document-class-name} d&lq ¥ SN, ¥ edy«l WsR weud B, Jadls WY
BRelAY-L sl shes 12,140 3l B, Jedls edidy-saidd [Asedl yo €l 8, shes 12240

AWMLY, [Aseu e B,
£3cNAY-541 Gaa (Guyddal)
article Wda Al @ual 32
book 1Y, Yads avial W2
slides Medel H2+ll S srllddl 2, UL §iees] 52 20U 0 uS U B
letter Yo dual 2
beamer ofl3R Wdayell Gualol s34 WiBu2 ¥q ¥ uedq olrlaql w2

Aes 12.1 : k2eus WHIAL Sldy-5e
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s s
10pt, 11pt, 12pt SRAAYL Hou gired 46 10 Uidee (ydRulRa), 11 dide2 ¥ 12 i
ALAL W2,

adpaper, letterpaper, Udi 46 afl seal W2, L s Yei-yEl VidRAYIM wdidi s 8,

legalpaper i Rl Gudlol W2 A4, AR B ¢l A WY s B,

fleqn Wil viA WU 92 s sed ol eny (g BendH)
salaal w2

landscape gAYl AUl Al W2 (2 WAL oA WR)

res 12,2 @ dzdls saldar-sela- 24l W [Qsey

aslars Weardl wdud wedl excudeil s R saHl wd B, d25u ugla Wl ¥ dadls e
ASUARAA 3R Yl W B, uig Gudoisdll RS ¥3 oY ¥ Y3 Wi Al Buell auRiel AdLag
W2 A2su Guilatsald Wi W oiriccledl Aadd 2wl B, A2su Gudasaldl NA e B, ¥
vl dal Wy ol 9 vaal uEKawl du A W Wil ¥3Rud 3o 38R s3I0 dn
Comprehensive Tex Archive Network (CTAN) Gu: add &.

A2sudl ial uastl Wiy udddfl o MeuRd s3al Q. B, el erldoml vial s Al A
atd Wardl Guylal Rl u, dl Al URdES eudl (Urdia-uMi) \usepackage{package-name} i
R N0d2 (R5A2) sal W B, J2als W A add 44l sl W2 Asel ua du . A 3uni-u
AS uR [Asaudl Gual 28 A sdl &, dl Bs ¥ addil 3ls o \usepackage s A s
Rl 4R Wam ARan udld ;e (Rsd) s asu stes 123410 J2dis -t Gyl
vadi Wi caladini vien 8.

ey ag-t

amsmath ul Wl A2l AR WAl [Ardel da B, yued Ad 23R4
Afd AWl WS s-uqudi wwdd.

color BBl sdR Gl R

easylist s sl ay Rl wel Gla w2

geometry Wil AL W2, FHE Urllg 46 Al R, @ (ARBRAA) Al sRd
WlEd dsdl 52 a3

listings gxdldonl UMl S8 GARalL w2

setspace A qa-l woul s w2 (Qd-RARL)

et 12.3 : wHry A Gl vuadi W

a2sudl needll gaiderd usam 245



~— cc  c  cr ey ey,
ayil R A% 225l Y wiadi wd B, ¥ 1A eulda B :
\title{the-title-of-the-document} — €t} iy
\author{author(s) of the document} — dld¥«il dvis
\date{date of creation / last update of the document, in any format} — gdldy sirlons{l didlw

o 25U duiA W2 WdRURA A s %A 2 A d Susdl €, dl ad flds wAd Quisl
WRAL Y3l wil o3dl 8, wig alv culadl WBreud 8, A 20 WRA YA wiaril AR wa d,
sanddadsll v dids a3 Qamii g, 2 R Urdid-mi viadl dl edldy Avauddeul
UM g ddld vl W 8.

g2didy A-yii-2 (The Document Environment)

dul A WSS H2rl Ry rllilred oo ealAell You Ruuargd wdrg s sl v s
A25A g1l @dAARA A 2« U A \maketitle s ANad, vasiq \title, \author M- \date
sileg \maketitle udal w0 aal ASA. 51293 A URAL ds wRdl Gudloll wd B,

s adsil qel [Aga Qeuat OIS ud wdsd dui-i 2L euol-l 2AREs &S A3, Yadsdl erddy
Becuyedfieen Yo oL e Roulrd 53l asiy - 20l R, e RoLd A uisardll Ratd, s 22
24N \frontmatter, \mainmatter A \backmatter s~ Wyaii wd 8. 2 [RAY QAeusdwi
WAV gl S U, Fud woladl Rowdd dls, Ruuagd Ses 3 Jrdladl a3y wwsardl
@owell siayR, wdqsaBisn i Aeel YA 2w you Agaul wweldl wzudi webs Bya gy,
Qeusll A Y21 RewlL

Yalsell Ao [Auyard alsel sy, Q. 8. vl Yadsg [AQeudllal, [Aeudllg dswsl, nsw yervilaii,
yenlld Y2t el Yel qeivild da-la qeisda, a-l2) yeivily gsuslil, 50 el 504l
Rouwd sRami wwd 8. 20 W2 2dsA \part, \chapter, \section, \subsection, \subsubsection,
\paragraph <. \subparagraph $ile¢ dlualil uid @,

8l sl S Bs e vvani v B, sl am As ARy e AU Ses
s, ¥ Adl Reus, 3sw 3 YA 43 5 B, e avienil eldail wag s ais] &S ad Ay
a widRs s6IRA v S ud (B3 HaAd wel s (eles) Al WA AL R (Saks))
o3 [AuuargHl Slesd siuail sudd s 2§ i Ay avuadl AldAdl ddadl W2 Al wiR
usid, si6 VIR suami 20dd i el w1 7 128l Asellnsll viex 2wdAdl QU S Axy el A
yalsdo 2uani 2wda du 8, Fuk Rowatd a1, K@ 2 0, yar a1 «dd,

d2s @1l [AeUL, UKW A Heild AUAU™_L deeidioiR vuradl vd 8, W w2 dvid Rlal L
Al Al dus usml, Yel-dal Yl s31 o AU 3Rl A 8. 2 W2 s3I auid wgsU-eR
viualfl dl datl ¥3R Wl Ayl QRowollrl s Al wy & (I, I, IO, adl3), W u4RWL,
el w2l el ddlidl wgsn WRBEHD v 8 (1, 2, 3, ).
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\appendix s udldl (¥ Ws ¥ aud Ml wnu B) sul ¥ wswl WRER ddF wnwuni w4
8 2l AU sitel wesdesR W2l HeuaR 4 vl 2ud 8 (A, B, C 4dli). 2wLa-l YgRidi Wizl
iAHl wgseioR uAdl A B, WU YU YR i WeKsAL ARl WIBL WpdeR
sl wid 8, ¥ 1dl 13 ud, 2o Yeor B Wl Yort oAl e €Y B (Bl 3 Mrdlasl,
sojdldn, Aayf). 2ial usedd i Jd usld 3 Q22 ddl dl, sdida-d el q2s saldd
sl viRell wowdl iRl (*) ya €S ud, Gers® adld \section® s BsribR AAR-AL YE)

olladl WS ANl ws

yoyd A 2igsEadsR 2 a2 Y 2l any 8. vled 3 1a yu Y 2wdl any 8. La-da Yyl
U AR UMl oUW MsHeAGR MMAPL Hadl +dl WA sigaal W2 A5l HRcadl widRs
olsdi F1R sAUA oeedl Asn GedW afld \setcounter{secnumdepth} {3} sl H2sl 7R 3
(a2l yer) Y vegsaeisi 20l B, YelRA () A wasl <ok dad Yo Hasdl 12R Aesarior
Yl As WAL S g vudle B, AN A wprrisiRA LS Rewdin: ¥ yslRud &g ol
wERRIA AEL A/ oz Wl U B, A s Yrdsen Qoudt I wsRR 5 2w Al ye 4en
ol ye 1 @, dl o1 2 Y 5.4.1 disdidisin wndnl 2ud 8.

\tableofcontents il UM 21 B, AU W YudRAd Nsda [Bnaagd ses (TOC) s ues
QU Azsuul G ol B, s3l auid, Rruargrl Sesd W 2 Yl du B (2w ya Ydl). uig
wun tocdepth uidRs sy ad seedl wsy 8.

wdl As cdlual Fdl wgradl YA A B ¥ A2 Arlgidadl ngell via Y s42: Ak o avidsil uBa
538 el g Gy H1dA YRl drld 8. d sldadl AN uA M 8qHq el L Wy WA
8. eadldoril Ruuasgy ses udal did cllR wel widiqeR A useL A Yerll 2Byl Al
WAL B, N Bl delsd AU R 3 qeldll QA URA &dl el wudl wRRARML A2su sl
quid R &g WQ 8.

ned il Q25U eddldarl wawl QA AR @l 52 B A Ws Yy sidanl Wae N B, w
detsd wGeye sndarl TOC vudl i 8 uual 9l Y s1da-ll uRA euld 8. ofla 1l A YW
gdaniel Wl wRA Asdl 5N wgsianl Wy TOC (RAnuagd Ses) oid 8.

TOCAl Fuy A2su sl wel, sresdl wel, vl Aoy (Ws Yaasl olwm ssudl Fia), gia-
YR, wReufs asesla dual wpsuRia Avl B, 2 ol o azg duisdl ouR gnal 3 B A -
o 530 25U Weuld B,

[cTATET "]

258 s &5 Ad olsd B, A Al W2 WA s Arlsda oudlBl v dd wGye AW, W
GelgReril 2uwdl d2sd WA SciTE »Rerdl Guwdla sy,

o SciTE Rzl File = New Aqfasen wie 3 «dl side o-uql

o [RREa 12140 wild WRA SciTE Rzl (adu 1) dul,

a5l needl ereldwy sl 247
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\documentclass[12pt] {book}
\usepackage{amsmath}
\title {\huge Mathematics \\[3\baselineskip]
\Large Standard 12}
\author{Gujarat State Board of School Textbooks}
\date{2013}
\setcounter{secniumdepth} {2}
\setcounter{tocdepth} {1}
\begin{document}
\frontmatter
\maketitle
\chapter{\MakeUppercase{Fundamental Duties} }
\tableofcontents
\chapter{\MakeUppercase{About This Textbook...}}
\mainmatter
\part{Semester I}
\chapter{Set Operations}
\section{Introduction}
\section* {Exercise 1.1}
\section{Properties of the Union Operation}
\subsection{Union is a Binary Operation}
\section{Properties of the Intersection Operation}
\subsection{Intersection is a Binary Operation}
\subsection{ Associative Law}
\chapter {Number Systems}
\section{Introduction}
\section* {Exercise 2.1}
\section{Irrational Numbers}
\chapter{Polynomials}
\chapter{Coordinate Geometry}
\chapter{Some Primary Concepts in Geometry : 1}
\chapter* { Answers}
\markboth{\MakeUppercase{ Answers} } { }
\addcontentsline{toc} {chapter} { Answers}
\part{Semester IT}
\chapter{Quadrilaterals}
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\section{Introduction}

\section{Plane Quadrilateral}

\chapter{ Areas of Parallelograms and Triangles}
\section{Introduction}

\section{Interior of a Triangle}

\chapter{Circle}

\chapter{Surface Area and Volume}

\chapter* { Answers}
\markboth{\MakeUppercase{Answers} } {}
\addcontentsline{toc} { chapter} { Answers}
\appendix

\chapter{Terminology}

\backmatter

\end{document}

R 12.1 : Q25uul Yras A5 Ayl

o File > Save AqRsar wie 530 sidaq Aa 50 wdl A Adl Al b s18ad wddoir tex
g AN

o Q2 sidan sUde sa W2 Tools > Build Rsew wde s (Wdsz 4 : F7) 2uGeye R-dul
geneity Azl 2uid, A L ATwRdAL del el (awetll sai) Exit code: 0 du dl g
SUSduL usel wy B, AR dl uuen ety 2. wig el AR A wdued s Yo 8.

e A suddud usn uay Y d), dsyil-e uRul sidd Aal W2 Tools > Go Aqsal wie .
(ész 4l : FS) SciTEAL 4ad &l yd Jsyilve iR ot sl oqadl R,

wudl A Al AN ¥ wud RRRAL 12140 yaed osddlni Jeaws 3w sl B, il dedls
alrRsad- ¥l wdl 50 qdl Q2su adudlo el d@wyel 8.

avuRL i3 (Text Formatting)

UL Q25U sUANML ALY §5 AR 4l esiledl GOR @ull wf il A5 AR usl Wil avigd
oed B, Az weurl udous, sleed st wA odsaslldl [Aseudl W skl 8 D I Jeg @
wdel dldi, Jeq avum oflm i A dog @vim R ugl wuad. d2su wls wsedd o cudnl
Rollrd sald a4 8. B srud d Ws e 6 cwol ReUBrd sl W3, dl d ol e wsal
W2 (<) L Bs-l Gudlol 2 B, Geldwl ddly formatting UMl st Wy Al 4 WS wsdl
Y, dl uddl Al formatt— uA AUR ugfldl dldBii ingdl a3 wa B,

ouiR oll® dg, Jedls WRERM 3 avieri deels dgRsl eigy 1l wad-uadl dldui Reulfrd 53
wsidl St el Geg® adld up to & Wkl B, Yid W el viadl up A ol HAA wzdnA
to avig WA el 418 ¥ ol 0oe) Aciat B U oAl d viadl B, A M SR WA, dl wUUs
oflz il AU to At AT wuad WAl

a5l needl ereldwy sl 249



o
2l B4 UUAA QAR QY wqdd B, 21 TdAd wAdLAL W2 up uel to sinl wse) AS 2s M

o ddl ASA. s dl wddl M . oflw N A2suul wWd KAl HZ A wel 9 3o -
any Adl wou ~ (2d&) ey R suladmi 2ud B,

A25uul stven =9 ol Aeulrd LAl »id 8. Aiq (ARs uat sl asy), AA ARg 2R MR,
Anet gleel Iviiel vidul 24 wdl 1l du B, Ay ARgA wdl 24 2udl Il el Al 23 e
gl-2 oL o Aad w2 AN wdus qud B, i Ad DARAA slee-dl Guadlol szl A8 aval
U2 Wy B, Ul Adel §le2 A HaMd §iv2 B, L 20U UsRell sived)l GUEAL s W2 \textrm {text},
\textsf{text} uA \textit{text} 58 aru wsid. gl 12.240 ail AR w1 Ay AR §lr2 qArll dglad
RS asell, i sl Rowst yaod ARg giredl 2 o)) Roudl Aw ARe sivenl B,

\tiny, \scriptsize, \footnotesize, \small, \normalsize, \large, \LARGE, \huge 17, \Huge $4i~$ a3 §ireril
seil 28R 530 as, wdl A Al Al ¥ sues Ju-ARBa D, \textbf, \textit 1A \emph 1wl Gurlol
avieri wg (sles), i (S2Rs) & elr saladl (Ruurd Ad oA Fdl o) 2 2NaL S Yy D,
\textsc Sl GUAOL Al el 2l wad (GR2a wer) sufddl wa & il fixlkZe Warel
\textsuperscript ¥ \textsubscript £ 43 avigi JUARIR (s RAa GuR KRg oy Ra) v Al
(s Rl QA s3d oy Ra)il avll asy 8.

g5l oligaell (Paragraph Formatting)

A2sunl A el a2 vidr UAmal 22 setspace Akl singlespace, onehalfspace, doublespace win
spacing {amount-of-spacing} A~aia-il-2 Guasy 8. A2suui aeyd Ad ol avia dyel 6Rq Nsada
(¥2615) u 8. A avia gofl drg, ¥Rl dig waal qd AU L ssaq u, du flushleft,
flushright 21\ center A-aiu-lA-2-l Guadal 53l W, Ha-l 12 2l $57 slle sl asl-u ssu-l
uddl dlZ e wou 6l davd du B,

g5+l A3xUanl el 9ld \indent ¥ \noindent sHuws=l Gualal 530, uddl dldlrl vl gdu YLl
3 o 9leefl A ~18] &9 Ay B, verbatim W-awu-d-e UG sul o2 WBeyz Fu B An (WA AR, WUl
“dl @l winl d24% s ARA) o Wl B. moreverb Waar-l3ud A8 Y el ~isiR vyl w2 Bk
§30rd w1fe-udel ldlA) piqsrrisi-Ae As YRRA (AREL) A yi ud d.

Yy &-2uB2 (Page Layout)

d2suui geometry Wil Gualal &34 widid duuGe 2wl usy B, \usepackage LUl Wi s
A WA As@s wodde adld wa s wsu B eld, 0 A LU Wl s8 A4 Gud
Wi 1 S, DA 0wl 2 §a, asll suged Wl 1.5 §u 2 ol suyef 0l 1§21 slsd 8.

\usepackage[a4paper, top=1in, bottom=2in, left=1.5in, right=1in]{geometry}

Udid s Al WwuRd i 8. Wt Ad Rafd dugdl Bl wed se A4, dR
vedl ddie du . dud w-sN adpaper, letterpaper ¥\ legalpaper ¥ ealdl usu ). portrait
(o) el landscape Rsen @@ wrld 2WR¥Rud Asdl usny B,

gRclldo s ouy iual 6 ouy sulddl €l B, Au HOed A& 6Ly, WU WA o sy swdg
Qu B, ol suy owdd eadldw dol Wel (A1) awr wHew Wl (AL)H0 v vadr . €4
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o
oel uldl wsin B, cudfFo (Al ded) s -l vudl ooy Blsadi W B duy U wd)
Fav uel & % wserl a3vid WS wel Guell adl A,

azsuul Rl wualld 216udlEor (Typesetting Mathematical Content in LaTeX)

A2suul wRel SURIfLs MR 2020 Ssd]l una-l addl B, wARS ALARsa WM si-lda
amsmath, amssymb ¥\ amsfonts W3-l Gwat s sURIks AN sl Ag AdddLey W)
A2suul B,

amsmath V3% uRRSs WH3 WS qeiot] Aruasdi2 Hqrld 3 0. 2SUARSL M2l & R
8. Yol 2 Wl B D Wy A0 sl Al dl dda AN sl Y 8. math

ArdiysA-edl Gudlol s3A udal i |@gu Aadl wsiy O, @k uelYl displaymath W-qiy-i-e-dl
Gulol s2dl W 8.

als28 (equation) wriuddl-2 ¥ g display Avcludide 8, ¥ w{ls@-a s4 wdwun sald 8,
aviemi math BrcnyslAvedl GualoL sl AL 2l 3 B 3 suBs aviel w3l $...5+0 axd awdl,
wRIRs Vrau-idedl eds uoed su@las g ald cwami wd 8, ¥ 202 (dvueld) eyl
Sl %g 8. W AequudA-ed well Ad anya w2 RRSL 12.240 2«ld S+l 2s tex §16d siaudl

o SciTEMi File = New AqRseusl see @ «dl sida oiwudl,
e [RREa 12240 »wld @uua SciTE 2Rz avil

\documentclass[12pt]{article}
\usepackage {amsmath}

\title {Introduction to \LaTeX}
\date{May 2013}
\begin{document}

\section* {math environment}

The quadratic equation, in its general form, is
\begin{math}

ax2 +bx+c=20

\end{math}.

You learnt about them in class X.

The quadratic equation, in its general form, is $ax*2 + bx + ¢ = 0§. You learnt about
them in class X.

\section* {displaymath environment}

The quadratic equation, in its general form, is
\begin{displaymath}

ax2 +bx+c=0

\end {displaymath}. You learnt about them in class X.

\end{document}

[@fEa 12.2 : Math S-uuideg ued-
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o File & Save AqRseuril Guddl s34 s1deq Ao A
o ¢d A2 $idad suda sl W2 Tools = Build Aqfsen wie KU (Wds2 4 : F7)

o 2 HUSAU Asadyds 9y DU d, Yoo dsyi-ecaiul sida A w2 Tools > Go
Aqasey waie s (Wése 4 : FS5). aus 12.340 au sidad wubeye sulda 8.

math environment

displaymath environment

The quadratic equation, in its general form, is

ar? +be+e=0

. You learnt about them in class X.

The quadratic equation, in its general form, is az® + bx + ¢ = 0. You learnt
about them in class X.

The quadratic equation, in its general form, is ga:® + ba: + ¢ = 0. You learnt
about them in class X.

aupld 12.3 : [AfREa 12240 2004 Si3-u 20B2ye-l Ws MuaL
auflas A (ieu) Gudlal (Using Mathematical Symbols)

ARl gsidl RAF) Gudlol 53 8. xdl 2uud A2sunl Gudll 2iddi vual suRks AR 2l
A4, 3lls Houael A d-i s 8, Bl k \alpha, \beta, \gamma, \pi 4913 dirl &R si-id B,
UL o sHIgell Ude AR {2 war da, d) Gelgw a3 \Alphadl d 35 el DA waR oAl B,

W GuRid SuRilis RAL w2l ya Jedis U 8, AMS Wl Guylal s3ld 2ugl 12.4 21 wugld
12.541 wual Jeals A2sudl siled A d-i oulis Rl safaani wen 8. Barbidi RAW sin,
cos ¥l ofla ol 2 s eulad sRRL W B 3 Ad W@dal wd sl (AR qdd el wsn

3 Ad olsddill 3R du B,

< < | = =
= = | \leq <
Yaeq > | \neq =
\times x | \div +
\pin £ [ Liop b=
hin € | \notin &
s > | fsnbset -
wsupseteq | 2 | \subseteq | €
\eup U | \eap N

2ugld 12.4 : A2suui auidl kzdls culilas s
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Yeong D \ proplo s
\rightarrow » \ parallel |
eftrightarrow ‘ \leftarrow —
Yangle / 4 bigadot ©
\ . A \ = . ; 3 —§
\triangle A voverleftrightarrow { AB} | AZ

. — = _ _ —
vstackrel frown{ AB} | A voverriglitarrow { A DB} AD
voverline {AB} ADB \perp 1
157 {\circ} 15° Yimplies —
yaft = | Ytherelore

Y because \ sl Sin
\cos COS \ tan tan
\sec sec \ ese CSC
\cot cot Y theta 6

augla 12.5 : A2sanl qurldl ay d2dls s dsuwl

suffas wBud- Gudla (Using Mathematical Operators)

A2l wen oL SRS UBAAA Gualal Wy B, uig war A Wkl uBus (x2) v SRsux
UBUs (x1) nadell 2uapil suad) <ol a0 W2 s ey PR uBus A (B2 aR) ud
WAL W2 UBAS (AR 2A) Gudlal Wy 8. YuRe wFus @l GUR dig WA
Wi avuad A ds sald B, oA UBus aviadl sed w2l B, Aysl Bud ealaal w2 veladld
o Goll ldl | a3 audil wd 8,

[RAY “laql W2 \frac{numerator} {denominator} s4iesell GualoL iy B, w3 x Avale A sl
W2 \sgrt{x} L=l Gulol ey B, W WBUA AR S 3. Ned 3 o enwsd As wuyals
ollm 2y@lsni n Guasdl s ofln wyrisui QS 13 @33, 2 w2 A wulel el 20 W3 uesel
56 A Al s A2su WA o AN B, W W A A Sl Gudal wa 8, Rk 12,340
AMRIRs wBuA- Gudlol ealag Gewdw 2uda B,

o File > New Aqfsau) Gudal 53 SciTEU <dl s1da a-udlL

o [ARZL 12330 ala avud SciTE ARz aviL

azsudl ueedl ekendwyd s 253



A e e e

\documentclass[12pt]{article}
\usepackage{amsmath}
\setlength{\parindent} {Opt}
\title{Introduction to \LaTeX}
\date{May 2013}

\begin{document}

\begin{math}

x 2 \\[6pt]

x_1 \\[6pt]

x_i\\[6pt]

x_i*2 \\[6pt]

x*y \[6pt]

a’bc \\[6pt]

{a"b}"c \\[6pt]

a*{b"c} \\[6pt]

\frac{x}{y} \\[6pt]

\sqrt{b} \[6pt]
\frac{\frac{1}{3}+\frac{3} {2} }{\frac{2}{3}-\frac{1}{2}} \[6pt]
\frac{-b\pm\sqrt{b"2-4ac}}{2a} \[6pt]
\frac{-b\pm\sqrt{\Delta} } {2a} \[6pt]
\sqrt{1+\frac(1} {\sqrt{1+\frac{1} {\sqrt{ 1-\frac{1} {2} }}}}} \[6pt]
\sgrt{(x_1-x_2)"2Hy_l-y 2y*2} \\[6pt]
[x-yl \[6pt]
(frac{x_l+x_2}{2}.\frac{y_l+y_2}{2})
\end {math}

\end{document}

[afEa 123 : sulfilds wlusld Gea
e File > Save Aqfseu a3 s1dad Aa £
o ¢d Tools > Build AqRsed (g2 4l : F7) wde s anwdl A2z sidad swda s

o A AsnAyds swddad wy du, d Tools > Go A Qsew (aldse 4 : F5) @ Ayl
QuMl sida gl WA 12,6 dsyilre il s1dad 2qwGye eald B,
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8
—t
L |~
e
W o]

Z+
T —b+Vb2—4dac
(A
2a
72 —b:|:\/_

v \/ \/“\/—

Cl,bC 5
r1 — 22)? + (y1 — y2)?
a’*
Il‘ — yl
b€ \
a Ilj-I_, yl-gyz)

Y
il 12.6 : RRE 1234 A RQeusni Reulra 2082y

adls20-) Gulel (Using Equations)

Azsu wlsrell W2 A v w15 (equation) Wraiudde Y3 uR 8. e35 als2d WK (equation)
A-uddedl quianl wd B, dA aRd (Math) RA-<u-iA-eul Adl 2adl el wlseld
WYAG BsH doR Ul Wd 8 A Il Slsaauni wd 8 (center-aligned). RRESL 12.430
A5 (equation) ANercwyddeed Gelda eafdapil el 8. duy Wl 12.740 subeyeddl euol
ealaqml el 8.

\documentclass[12pt]{article}
\setlength {\parindent} {Opt}
\usepackage{amsmath}
\title{Introduction to \LaTeX}
\date{May 2013}
\begin{document}
\begin{equation}

\sin*2\theta + \cos"2\theta=1
\end{equation}
\begin{equation}

Asuell ueell eradwd s 255



\sec2\theta - \tan"2\theta=1
\end{equation}
\begin{equation}

\csc”2\theta - \cot2\theta=1
\end{equation}
\end{document}

RISt 12.4 : wllsest (Equation) Srauad-ed Guda
sin®f +cos*d =1 (1)
sec’f —tan’b=1 (2
csc?f —cot’f =1 (3)

gl 12.7 : [@REN 1244 2ubeye
A25u-0 Sl (Advantages of LaTeX)

A2surll HRUNYL Al B, 25 sl [Agd sl wida O, A2sud uR Rgd s3I wslu. dsunl
“ai qaRl G W2 vadl As(@s wudlsem w2, A2su-(l YRR quikal w2 A ya A qI-L
Wy ol 92 B, unsL Aunl Q25U qulasdixl g ARY w3Ruidl Y3l wisal A2 val ¢ L3y
sl vl B, wnidi waioti Ve Fiyes 8. A CTAN (The Comprehensive TeX Archive
Network)l dmuidz website at www.ctan.org GU2 ¥z sl Al 8,

A25 el RIASs Yol AR 2 Aoy A sl 2 vl % WE V. B 418 o d Avis), SARxdAwRAL
wsias), Suadl, sayafisud wqd ol asldl Rl wor dsfu 8, ofly sra A 8 & d Ws vy
o qafid UL 8 A dadaeldl daRis cnadt ud wgdoll RAsudami 2w B, ol d
Rraziaollbl i Rl ye dsBia 8. i Aste dlsl A2surl Gualal 53 8, Wldiei Hdal v wir@dl
add B, el Hee 51 O A A2suAL Ay [AsA W2 dal W 6idld B WA Qs 5 D,

A2suml UAR Birjsrrio vivalll w1 Aecl ualdl duar AR RNudgd Sves, wsilia wd
ofl® awudl o3Rud Y Wl wAas 8, ¥ Avisl WeARs olwl gudl 53 B,

AlRieL

2 usRUE WAL A2suel QUL sTA dsfgl wd uRiRks erudy &5 dd oNsaw A Al
A2l AW drdl ogdl, WA 2 A2 sldaeil WL A st Al 1l @R
ugl A2l Yol tldy &8 A sl duy &5 Ad s, A+l vl 7 wd Bed A2l
Y disld - Uy wa3l 58 Ad oNsad d AS ol A useuBusdl &8 A yg W B, a-l
gt YUl 57 A vidul A% sweRddl @l

256 swle-vtayq : 12



SciTE iR Q25 s[4y 54 (s5d Rmal )

o ¥ SciTE wddd]l wdq &u dl sl s\
o 2RlMa alun A
o AN s I KA :
sudo gedit fust/share/scite/tex.properties&
vl osuss wnael gedit AR2R s wad, Adl fA WA FwR A
o AN LA s Al :
file.patterns.tex="* tex;*.sty
file.patterns.context="*.tex;* .tui;* tuo;* sty
ddl A 3 dd A wdl A Ll Yl
file.patterns latex="* tex;* sty; *.aux;* toc;*.idx
o ]l oedl :
command.go.$(file.patterns.latex)=gv $(FileName).pdf
LIRECIC
command.go.$(file pattems.latex)=evince $(FileName).pdf 12l axi
o sdad A s3I gedit sid KU

o SciTE 43 3. dlou 25 s19e wlell F7 il F5 eslid). 254 s18d s2uda add s (s
glde vadl. SciTEW Wd dl yd Ylduls s1da ide oy 4.

eltauy
aveuBus Wl sl wnuHell s oAl WA wA asal wAl-)l wel dur s
A2siell elsBudii yeu sRR0Al wel dwr s
Qs Ml GURAL A s WHA Al AN B WAk wAAl Wl dwr WL
d2sRu-eclld] Wy WiMAL
\frac siIrs 2 ¢ \frac sHIs Gelgel AlRd AdMA),
2 wlen [Qsadmidl oy [QAsey yaie 53 :
(1) 2y[s aceuBu dlgeda QAU &5 ugld wwd wd 8 ?
(2) WIGIWIS  (b) WISYWIG () WYSIWYG (d WISYWYG
(2) DAuniefl s Bl WYL Q25AHL ] ?

@ @ (b) % © $ @

A

a5l needl ereldwy sl 257



(3) ~NA-uniel sy \begin{name}el U3 wu B - \end{name}ell y3 wu & ?

(@ b) 3a ©) Wraudd-e (@) W~
4) DAriuie)l 0 v A2l S (RBwell) w2 quaw & ?

@ § ) % © # @ &
(5) ~lRAHl 9 oudl A2sudl N2rkel qud & ?

(@ wei@s owar (b)) TOC (©) Wellaril @ FA~uudie
6) DAl 5§ Amwde A2su-i Wy 4wud & ?

(@ CTAN () CLAN (¢©) CTEN @ CLEN
(7 DArniel 2] wNAR visrdioiR g -l ?

(@) \section (b) \subsection (©) \chapter* (d) \part
(®) DAdmidl & Wraudide aumedl i uRilas Ruuarg suld 8 2

() displaymath  (b) math (c) equation @d) text
(9) NA-unil s s YR R o-ud 8 ?
(® \cup (b) \sctunion (© \eap (d) ‘\union

(10) wesrs maa a@e sdlaa w2 fA4pidl s wBus auay 8 ?
@ _ (=sR) (b)) A (332 (© — (cuesus) (d) < (Al s2al »])

(171) DAl & wrearini yud 6l ddy auay 8 ?

(@) \usepackage (b) \title (¢) \maketitle (d) \documentclass

walbis ety

1. 25030 vl Yacsil Aworoirll sl . A3l wiasy, Buaargy shes, wsel, qevd, Qa0 yeiil

Q3L wda s eds [Qelol s wsel @il

2. avie-dsam (S81Gs1) euladl A4y exudyw oewd),

3. gsuedl olsam (SUIRal) euladl Ay AZsu-erdidy AwR s

4. W5 Asu-tdy ol Y ApuGe WA -l udol S

5. 0 wld Buyagdl s d2su-8dldy ddR A -
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(8 FA={x|xe N, x<4)},B=1{1,0,1,2 3} and C = {0, 1, 2}, then
(AUB)N(AUC) ={0, 1,2, 3, 4).

by fA={x|xe N,x<7})and B = {2, 4, 6} then B c A.

81% 216% 1l
CX B8 g0
(625)* (8)3

©
@ XcYadYcX=3X=Y
(c) PONPR=P

) BEnEG={E}

@  sls—aXs—h)s~c)

@)  Areaof ©(0,r)=

@ Var2db=x+fy
x=a+\/a22—74b’y=a—\/c;2—74b

)

htanc — tanj)
(k') tﬂnamnﬁ

asudl seedl cridyy usan 259



	comp_12_g_1
	comp_12_g_2
	comp_12_g_3

